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1. Who is the present Vice Chairman of NITI Aayog? 
(A) Suman Bery (B) Rajiv Kumar 
(C) Aravind Panagariya (D) B.V.R. Subrahmanyan 

2. The famous Hindu temple situated in the valley of Brahmagiri hill : 
(A) Kottiyoor temple (B) Palani temple 
(C) Thirunelli temple (D) None of these 

3. In which of the following is a artificial lake? 
(A) Dal lake (B) Wular lake 
(C) Gobind Sagar lake (D) Sambhar lake 

4. In which session of Indian National Congress decided to observe 26th January of every year 
as the Independence day? 

(A) Nagpur session (B) Lahore session 
(C) Bombay session (D) Amaravathi session 

5. Wajid Ali Shah, the ruler of which one of the following states was removed from power by 
British in the name of misrule at the time of 1857 Revolt? 

(A) Awadh (B) Barout 
(C) Arrah (D) Delhi 

6. Mannath Padmanabhan organised Savarna Jatha in support of : 
(A) Guruvayur Satyagraha (B) Paliyam Satyagraha 
(C) Salt Satyagraha (D) Vaikkom Satyagraha 

7. Who wrote the famous book ‘Prachina Malayalam’? 
(A) Sree Narayana Guru (B) Chattambi Swamikal 
(C) Vaghbhatananda (D) Swami Dayanand Saraswati 

8. The best FIFA Men’s Player of 2022 : 
(A) Christiano Ronaldo (B) Neymer 
(C) Harry Kane (D) Lionel Messi 

9. The town located on the confluence of river Bhagirathi and Alakananda is : 
(A) Rudra Prayag (B) Dasa Prayag 
(C) Vishnu Prayag (D) Karna Prayag 

10. Who won the 52nd Odakuzzal award? 
(A) Ambikasuthan Mangad (B) Sara Joseph 
(C) Sethu (D) Mudnakudu Chinnaswamy 
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11. Which of the following is the brain of the computer? 

(A) Central Processing Unit  (B) Memory 
(C) Arithmetic and Logic unit (D) Control unit 

12. Which of the following is an output device? 

(A) Keyboard (B) Mouse 
(C) Light pen (D) Printer  

13. How many bytes does 2 kilobytes represent? 

(A) 512 (B) 1024 
(C) 2048 (D) 256 

14. Full form of URL is : 

(A) Uniform Resource Locator (B) Uniform Resource Link  
(C) Uniform Registered Link (D) None of these 

15. Which operating system is developed by Apple? 

(A) Linux (B) Window  
(C) Mac OS (D) DOS  

16. What is the name of a device that converts digital signals to analogue signals? 

(A) Router (B) Switch  
(C) Modem  (D) Repeater  

17. DPI means : 

(A) Dots Processing Inch (B) Dots Per Inch  
(C) Diagram Per Inch  (D) None of these  

18. Every computer connected to the internet is identified by a unique four-part string,  
known as : 

(A) IP address (B) Host name 
(C) Domain name (D) None of the above 

19. The Third-generation computers are based on : 

(A) Transistor  (B) Integrated circuit  

(C) VLSI microprocessor  (D) ULSI microprocessor 

20. Malware is the short form for malicious software and used to refer to : 

(A) Spyware  (B) Worm 

(C) Virus  (D) All of the above  
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21. –————— is the special kind of website which offers so many services to its users. 

(A) Web browsers  (B) Web servers 

(C) Web portals (D) None of these 

22. –————— is an example of search engine. 

(A) Yippy (B) DuckDuckGo 

(C) Bing (D) All of these 

23. Touch Screen is –————— Type peripheral Devices.  

(A) Input (B) Output 

(C)  Memory  (D) Both Input and Output 

24. Norton is an example of ————— Software. 

(A) Browser (B) Anti-Virus 

(C) Search Engine (D) None of these 

25. Who is the following is known as the father of computers? 

(A) Dennis Ritchie (B) John Napier 

(C) Charles Babbage (D) None of these 

26. What do we call a collection of two or more computers that are located within a limited 
distance of each other and that are connected to each other directly or indirectly? 

(A) Internet  (B) Intranet 

(C) Local Area Network (D) Wide Area Network 

27. What is meant by the concept of WYSIWYG in MS Word?  

(A) What You See Is What You Get 

(B) What You Seek Is What You Give 

(C) What You See Is What You Give 

(D) None of the above 

28. Which commands are present in Quick Access Toolbar in MS Word? 

(A) Save (B) Undo 

(C) Redo (D) All of the above 

29. Which of the following is an example of page orientation in word document? 

(A) Landscape (B) Subscript 

(C) Superscript (D) None of these 
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30. To Select all the text in MS Word document by : 

(A) Ctrl + S (B) Ctrl + 1 

(C) Ctrl + A (D) Ctrl + V 

31. The name of a word document displays in : 

(A) Ribbon (B) Title bar 

(C) Status bar (D) Home tab 

32. What is the shortcut key for “Find and Replace” dialog box in MS Word? 

(A) Ctrl + F (B) Ctrl + R 

(C) Ctrl + H (D) Ctrl + Shift + F 

33. What is the shortcut key for “Paste" in MS Word? 

(A) Ctrl + V (B) Ctrl + P 

(C) Ctrl + S (D) Ctrl + E 

34. In MS Word, which enables us to send the same letter to different persons? 

(A) Mail merge (B) Macros 

(C) Both (A) and (B) (D) None of the above 

35. What is the default file name of Microsoft Excel file? 

(A) Workbook.xlsx (B) Workbook1.xlsx 

(C) Worksheet.xlsx (D) Worksheet1.xlsx 

36. In MS Excel the intersection of a column and a row in a worksheet is called : 

(A) Box (B) Cell 

(C) Range (D) Page Break 

37. Which programming language is used to write a Macro in MS Excel? 

(A) C (B) C++ 

(C) Java (D) Visual Basic  

38. When a range is selected, how can you activate the previous cell? 

(A) Press the Alt key (B) Press Tab 
(C) Press Enter (D) Press Ctrl + G 

39. In MS Excel what is the syntax for power function? 

(A) Power (number, Power) (B) Power = (power, number) 
(C) = Power (number, Power) (D) = Power (Power, number) 
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40. In which function return the remainder after a number is divided by a divisor in EXCEL? 

(A) ROUND ( ) (B) FACT ( ) 
(C) MOD ( ) (D) DIV ( ) 

41. Which Chart can be created in Excel? 

(A) Doughnut (B) Line 
(C) Pie (D) All of the above 

42. Excel displays the current cell address in the : 

(A) Formula bar (B) Status Bar 
(C) Name Box (D) Title Bar 

43. Which of these is the page setup orientation by default of the slides in PowerPoint? 
(A) Landscape (B) Portrait 
(C) Vertical (D) None of the above 

44. What is a Microsoft PowerPoint? 
(A) Spreadsheet Program (B) Presentation Program 
(C) Database Program (D) All of the above 

45. Which of the following is called as page to create a presentation in PowerPoint? 
(A) Sheet (B) Slide 
(C) Document (D) None of the above 

46. Which of the following shortcut key is used to start the slideshow? 
(A) Using F5 key (B) Using F3 key 
(C) Using F1 key (D) Using F6 key 

47. Which of the following shortcut key is used to stop the slide show? 
(A) Esc key (B) Ctrl + O 
(C) Ctrl + N (D) Ctrl + K  

48. Which of the following shortcut key is used for help in PowerPoint? 
(A) F1 (B) F2 
(C) F3 (D) F4 

49. Which is the menu to create a text box on a slide? 
(A) View -> Text Box (B) Tools -> Text Box 
(C) Insert -> Text Box (D) Format -> Text Box 

50. PowerPoint presentation is a collection of : 
(A) Slides and Handouts (B) Speaker’s notes 
(C) Outlines (D) All of the above  
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51. Malayalam Typewriter was introduced by : 

(A) K.N. Panicker (B) Kerala Government 

(C) R. Arulappan (D) N.S. Pandala 

52. Rhythmic touch method is also known as : 

(A) Sight method (B) Staccoto method 

(C) Legato method (D) All of the above 

53. Type guide is fitted : 

(i) at the bottom of the segment 

(ii) at the top of the segment 

(iii) at the middle of the segment 

Which statement is false in this statement? 

(A) Only (iii) (B) Only (ii) 

(C) Only (i) (D) None of the above 

54. Items required for cleaning a typewriter : 

 (a) Long brush, Polishing cloth 

 (b) Oil can, hat pin 

 (c) Petrol, Soft rag 

 (d)  Screw driver, Cleaning paste 

 Which of the following is true in this? 

 (i) (a) and (b)  

 (ii) (b) and (c) 

 (iii) (c) and (d) 

 (iv) (d) and (a) 

(A) only (i) and (ii) (B) only (ii) and (iii) 

(C) only (iii) and (iv) (D) only (iv) and (i) 

55. Rocher Mechanism includes the functioning of the following parts : 
 (i) Pinion wheel, Escapement wheel 
 (ii) Escapement wheel, loose dog 
 (iii) Pinion wheel, Segment slots 
 (iv)  Loose dog, Platen 

(A) Only (i) and (ii) (B) Only (ii) and (iii) 

(C) Only (iii) and (iv) (D) Only (iv) and (i) 
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56. From the below given statements, which options are true : 

(i) When the machine is at rest, the loose dog is in action 

(ii) When the pressure on the rigid dog leaves the tooth and the loose dog catches the next 
tooth of the escapement wheel 

(iii)  When the character key is pressed, rigid dog is in action. 

(iv) Carriage moves by one degree when loose dog leaves the tooth of the escapement wheel 

(A) Only (i), (ii) and (iii)  

(B) Only (ii), (iii) and (iv) 

(C) Only (iv), (i) and (ii)  

(D) All of the above 

57. The ribbon starts to move from one spool to another spool automatically is known as : 

(A) Reverse movement  

(B) Automatic movement 

(C) Automatic Reverse movement  

(D) All of the above 

58. The expanded form of EFTS : 

(A) European Free Trade System  

(B) Electronic Free Treasury System 

(C) European Federal Temporary System  

(D) Electronic Fund Transfer System 

59. When the variable line spacer is used, the contact between the cylinder ratchet and the 
cylinder is ceased.  

The above statement shows that Variable line spacer is  

(A) used to cease the cylinder  

(B) used to rotate the cylinder 

(C) Both (A) and (B) are correct  

(D) Both (A) and (B) are false 

60. The figure 370 is written in Roman Numerals as : 

(A) CDXX (B) LLLDXX 

(C) CCCLXX (D) CCXLL 



108/2024-K A 
 

10

61. The publisher told me that my mistakes wouldn’t be a problem in the future. I thought he 
was very kind, but later, I realized that he was giving me a left-handed compliment. 

What does the idiom “a left-handed compliment” mean? 

(A) Positive feedback  

(B) Insulting remark 

(C) Approval  

(D) Encouragement 

62. Give a one word substitute for “a sudden complete failure”. 

(A) Debacle (B) Holocaust 

(C) Malady (D) Nemesis 

63. Find the word which is a synonym of “Cliche”. 

(A) Stereotype (B) Novelty 

(C) Creative (D) Original 

64. Fill in the blank with a suitable preposition : 

Negligence from the parents causes the children to look –————— affection elsewhere. 

(A) at (B) in 

(C) with (D) for 

65. Find the figure of speech of the following sentence : 

“My blood turned cold like the moon”. 

(A) Metaphor  

(B) Simile 

(C) Personification  

(D) Oxymoron 

66. Pick out the sentence which is grammatically correct : 

(A) Between you and me, everything is a mystery 

(B) Between you and I, everything is a mystery 

(C) Between I and you everything is a mystery 

(D) Between you and he, everything is a mystery 
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67. Fill in the blank with an apt phrasal verb : 

Looking past in life, I still can’t –—————. What went wrong! 

(A) Drag out (B) Figure out 

(C) Stand out (D) Drop out 

68. Choose the correct spelling : 

They performed the last –————— with all due respect, before the body was cremated. 

(A) rights (B) rites 

(C) writes (D) wrights 

69. Identify the sentence which is in the passive voice : 

(A) He has reserved his seat on the bus  

(B) They had finished only half the work 

(C) Let him be invited to the party  

(D) I shall inform them of this  

70. Choose the appropriate question tag : 

He chose a book, –—————? 

(A) Did he? (B) Isn’t he? 

(C) Didn’t he? (D) Won’t he? 

71. Would you mind –————— your car from the way? 

(A) move (B) moves 

(C) moved (D) moving 

72. In the following sentence, supply a verb in agreement with its subject :  

 Either the casts or the director –————— responsible. 

(A) was (B) were 

(C) are (D) am 

73. Mr. Bean saw a –————— of keys lying on the floor. 

(A) flock  (B) group 

(C) bunch (D) bundle 
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74. You must get some more questions, –————— You can’t complete your project. 

(A) whereas  (B) otherwise 

(C) however (D) moreover 

75. If I had known that you were coming, : 

(A) I would have prepared your favourite dishes 

(B) I would receive you at the railway station  

(C) I will take you to some important destination  

(D) I would ask you to bring some sweets 

76. Fill in the blank with the correct reported speech :  

She asked me –————— 

(A) if I needed lunch 

(B) do you come with me 

(C) does she visit this place often  

(D) do you like pizza? 

77. By the time we reached home, the thief –————— the spot. 

(A) leave (B) left 

(C) leaves (D) had left 

78. Fill in the blank using an article :  

Ramesh is –————— MBA graduate. 

(A) a (B) an 

(C) the  (D) of 

79. His explanation was so complicated that only –————— students responded to his queries 
in the interactive session. 

(A) a few (B) little 

(C) the little  (D) a little 

80. Put the phrases in the correct order to unscramble the sentence :  

 the most interesting movies / I have ever seen / This is one of 

  (a)  (b) (c) 

(A) (b) – (a)  – (c)  (B) (a) – (b) – (c) 

(C) (c) – (a) – (b) (D) (b) – (c) – (a) 
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81.  ‘£ÁPÀ’ F ¥ÀzÀzÀ CxÀðªÉÃ£ÀÄ? 
(A) £ÀgÀPÀ (B) ¸ÀéUÀð 

(C) DPÁ±À (D) ¥ÁvÁ¼À 
82. ‘¸ÀzÁZÁgÀ’ F ¥ÀzÀzÀ ¸ÀjAiÀiÁzÀ «AUÀqÀuÉ AiÀiÁªÀÅzÀÄ? 

(A) ¸Àvï + DZÁgÀ (B) ¸ÀzÁ + DZÁgÀ 
(C) ¸Àzï + DZÁgÀ (D) ¸ÀzÁ + ZÁgÀ 

83. PÉ¼ÀV£ÀªÀÅUÀ¼À°è À̧jAiÀiÁzÀ ¥ÀzÀ AiÀiÁªÀÅzÀÄ? 
(A) «zsÁåyð (B) «zÀåyð 

(C) «zÁåyð (D) «zsÀåjÛ 
84. PÉ¼ÀV£ÀªÀÅUÀ¼À°è UÀÄA¦UÉ Ȩ́ÃgÀzÀ ¥ÀzÀªÀ£ÀÄß UÀÄgÀÄw¹j. 

(A) E¼É (B) ¥ÀÈyé 
(C) s̈ÀÆ«Ä (D) £ÉÃ À̧gÀ 

85. ‘PÀtÂÚUÉ ªÀÄuÉÚgÀZÀÄ’ F £ÀÄrUÀnÖ£À CxÀðªÉÃ£ÀÄ? 
(A) ªÉÆÃ¸ÀªÀiÁqÀÄ (B) PÀtÂÚUÉ ªÀÄtÄÚ ºÁPÀÄ 
(C) PÀtÚ£ÀÄß ªÀÄÄZÀÄÑ (D) PÀtÂÚÃgÀÄ ºÁPÀÄ 

86. PÉ¼ÀV£ÀªÀÅUÀ¼À°è zÀéAzÀé ¸ÀªÀiÁ¸ÀPÉÌ GzÁºÀgÀuÉ DUÀÄªÀ ¥ÀzÀ AiÀiÁªÀÅzÀÄ? 
(A) ºÉ§Äâ° (B) ªÀÄÄAUÉÊ 
(C) VqÀªÀÄgÀ§½îUÀ¼ÀÄ (D) PÀgÀÄuÁ¸ÁUÀgÀ 

87. ‘D¢’ F ¥ÀzÀzÀ «gÉÆÃzsÁxÀð ¥ÀzÀ AiÀiÁªÀÅzÀÄ? 
(A) CAvÀå (B) DgÀA s̈À 
(C) C£Á¢ (D) CAPÀ 

88. ºÀÄqÀÄUÀ£ÀÄ vÀ£Àß §®UÁ°¤AzÀ ZÉAqÀ£ÀÄß MzÉzÀ£ÀÄ. — F ªÁPÀåzÀ°è §gÀÄªÀ QæAiÀiÁ¥ÀzÀ AiÀiÁªÀÅzÀÄ?  

(A) ºÀÄqÀÄUÀ (B) ZÉAqÀÄ 
(C) §®UÁ®Ä (D) MzÉzÀ£ÀÄ 

89. ‘ É̈Ã°AiÉÄÃ JzÀÄÝ ºÉÆ® ªÉÄÃzÀ ºÁUÉ’ F UÁzÉªÀiÁw£À ¸ÀÆZÁåxÀðªÉÃ£ÀÄ?  

(A) É̈Ã° E®è¢zÀÝgÉ ºÉÆ®zÀ PÀÈ¶ £Á±ÀªÁUÀÄvÀÛzÉ 
(B) gÀPëÀuÉ ªÀiÁqÀ É̈ÃPÁzÀªÀgÉÃ «£Á±ÀªÀ£ÀÄß GAlÄªÀiÁqÀÄªÀÅzÀÄ 
(C) vÀ¥ÀÄà ªÀiÁrzÀªÀgÀÄ ²PÉë C£ÀÄ s̈À«¸À É̄Ã¨ÉÃPÀÄ 
(D) PÀμ ÀÖ¥ÀlÄÖ zÀÄrzÀgÉ Eμ ÀÖ ¹UÀÄªÀÅzÀÄ 

90. F PÉ¼ÀV£ÀªÀÅUÀ¼À°è ¸ÀjAiÀiÁzÀ ªÁPÀå AiÀiÁªÀÅzÀÄ?  

(A) ªÀÄAUÀUÀ¼ÀÄ ªÀÄgÀ¢AzÀ ªÀÄgÀPÉÌ ºÁjvÀÄ (B) ªÀÄAUÀUÀ¼ÀÄ ªÀÄgÀ¢AzÀ ªÀÄgÀzÀ°è ºÁjzÀÄªÀÅ 
(C) ªÀÄAUÀUÀ¼ÀÄ ªÀÄgÀ¢AzÀ ªÀÄgÀPÉÌ ºÁjzÀÄªÀÅ (D) ªÀÄAUÀªÀÅ ªÀÄgÀ¢AzÀ ªÀÄgÀPÉÌ ºÁjzÀÄªÀÅ 
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91. ¨É¼ÀîQÌUÀ¼ÀÄ DPÁ±ÀzÀ°è ºÁgÁqÀÄwÛzÀÄÝªÀÅ. — F ªÁPÀåzÀ°è §gÀÄªÀ ‘ É̈¼ÀîQÌUÀ¼ÀÄ’ AiÀiÁªÀ °AUÀPÉÌ Ȩ́ÃjªÉ?  

(A) ¹ÛçÃ°AUÀ (B) ¥ÀÅ°èAUÀ 
(C) £À¥ÀÅA À̧PÀ°AUÀ (D) ¹ÛçÃ £À¥ÀÅA¸ÀPÀ°AUÀ 

92. ¸ÀPÀÄåð®gï (circular) F ¥ÀzÀPÉÌ PÀ£ÀßqÀzÀ ¸ÀAªÁ¢ ¥ÀzÀ AiÀiÁªÀÅzÀÄ?  

(A) ¸ÀÄvÉÆÛÃ É̄ (B) C¢ü¸ÀÆZÀ£É 
(C) ªÀgÀ¢ (D) eÕÁ¥À£Á ¥ÀvÀæ 

93. ‘ É̈lÖzÁªÀÀgÉ’ — E°è §gÀÄªÀ ¸ÀA¢ü AiÀiÁªÀÅzÀÄ?  

(A) É̄ÆÃ¥À (B) DUÀªÀÄ 
(C) DzÉÃ±À (D) UÀÄt 

94. PÉ¼ÀV£ÀªÀÅUÀ¼À°è ¥ÀæxÀªÀÄ ¥ÀÅgÀÄμ À AiÀiÁªÀÅzÀÄ?  

(A) £ÁªÀÅ (B) ¤ÃªÀÅ 
(C) £Á£ÀÄ (D) CªÀgÀÄ 

95. ªÉÄ®èªÉÄ®è£É, zÀÄAqÀÄzÀÄAqÁzÀ — F jÃwAiÀÄ ¥ÀzÀUÀ¼À£ÀÄß K£ÉAzÀÄ PÀgÉAiÀÄÄvÁÛgÉ?  

(A) ¢égÀÄQÛ (B) eÉÆÃqÀÄ£ÀÄrUÀ¼ÀÄ 
(C) £ÀÄrUÀlÄÖ (D) C£ÀÄPÀgÀt ¥ÀzÀUÀ¼ÀÄ 

96. PÉ¼ÀV£ÀªÀÅUÀ¼À°è PÀ£ÀßqÀ ¥ÀzÀ AiÀiÁªÀÅzÀÄ?  

(A) CgÀtå (B) ºÉÆ® 

(C) d«ÄÃ£ÀÄ (D) DPÁ±À 

97. ‘¥ÀA¢’ JA§ ¥ÀzÀªÀÅ ‘ºÀA¢’ JAzÀÄ §zÀ¯ÁVgÀÄªÀÅzÀÄ. F PÉ¼ÀV£ÀªÀÅUÀ¼À°è AiÀiÁªÀÅzÀPÉÌ GzÁºÀgÀuÉAiÀiÁVzÉ?  

(A) ¸ÁªÀÄåªÀÄÆ® ªÀåvÁå¸À (B) zsÀé¤ ªÀåvÁå¸À 
(C) CxÀð ªÀåvÁå¸À (D) s̈ÁμÁ ¹éÃPÀgÀt 

98. PÉ¼ÀV£ÀªÀÅUÀ¼À°è vÀzÀãªÀ ¥ÀzÀ AiÀiÁªÀÅzÀÄ?  

(A) DUÀ¸À (B) ¥ÀæAiÀiÁt 

(C) zÀÈ¶Ö (D) ¥ÁæAiÀÄ 

99. PÉ¼ÀV£ÀªÀÅUÀ¼À°è £ÁªÀÄ¥ÀzÀªÀÇ, QæAiÀiÁ¥ÀzÀªÀÇ DUÀÄªÀ ¥ÀzÀ AiÀiÁªÀÅzÀÄ?  

(A) ªÀÄ¼É (B) ¸ÀÆAiÀÄð 

(C) gÁd (D) PÁqÀÄ 

100. ‘CAUÀ¼ÀzÀ°è’ E°ègÀÄªÀ « s̈ÀQÛ ¥ÀævÀåAiÀÄ AiÀiÁªÀÅzÀÄ?  

(A) ¥ÀæxÀªÀÄ « s̈ÀQÛ (B) ¥ÀAZÀ«Ä « s̈ÀQÛ 
(C) μÀ¶×Ã « s̈ÀQÛ (D) ¸À¥ÀÛ«ÄÃ « s̈ÀQÛ 

————————— 
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